SnapCenter® Software 4.2

Data Protection Guide
For SAP HANA® Databases

August 2019 | 215-14395_A0
doccomments@netapp.com

Table of Contents | 3

Contents
Deciding on whether to read the SnapCenter Data Protection Guide
for SAP HANA Database ........................................................................ 5
SnapCenter Plug-in for SAP HANA Database overview .......................... 6
Data protection workflow for SAP HANA databases ............................... 7
Preparing for data protection ...................................................................... 8
Prerequisites for using the SnapCenter Plug-in for SAP HANA Database ................ 8
Storage types supported by SnapCenter Plug-in for SAP HANA Database ............... 9
How resources, resource groups, and policies are used in data protection of SAP
HANA databases ................................................................................................... 9

Logging in to SnapCenter .......................................................................... 10
Backing up SAP HANA databases ............................................................ 12
Adding databases to SnapCenter Plug-in for SAP HANA Database ........................ 13
Creating backup policies for SAP HANA databases ................................................ 15
Creating resource groups and attaching policies ....................................................... 17
Backing up SAP HANA databases ........................................................................... 20
Backing up resource groups ...................................................................................... 22
Monitoring backup operations .................................................................................. 23
Monitoring operations in the Activity pane .................................................. 24
Canceling the backup operations ............................................................................... 24
Viewing SAP HANA database backups and clones in the Topology page ............... 25

Restoring SAP HANA databases .............................................................. 27
Restoring a database backup ..................................................................................... 27
Monitoring restore operations ................................................................................... 29
Canceling restore operations ..................................................................................... 30

Cloning SAP HANA database backups .................................................... 31
Cloning a SAP HANA database backup ................................................................... 31
Monitoring clone operations from the Jobs page ...................................................... 33
Canceling clone operations ....................................................................................... 34
Splitting a clone ......................................................................................................... 34

Backing up, restoring, and cloning using PowerShell cmdlets ............... 36
Creating a storage system connection and a credential using PowerShell cmdlets
for SAP HANA database .....................................................................................
Backing up databases using PowerShell cmdlets ......................................................
Restoring SAP HANA database using PowerShell cmdlets .....................................
Cloning SAP HANA database backups using PowerShell cmdlets ..........................

36
38
41
43

Troubleshooting data protection operations ............................................ 45
File-Based Backup workflow fails at custom file path ............................................. 45
User store key not found ........................................................................................... 45
Invalid user store key ................................................................................................. 46
Unable to access SAP HANA system ....................................................................... 46
Unable to access tenant database .............................................................................. 47

4 | Data Protection Guide for SAP HANA Databases

File-Based Backup workflow fails ............................................................................ 47
Unable to find Snapshot copy after successfully creating the backup ...................... 47
Backup operation fails if Snapshot copies on the secondary storage reaches
maximum limit .................................................................................................... 48
Catalog entries are not deleted after volume based restore operation ....................... 48
Invalid HDBSQL OS username ................................................................................ 48
Backup operation fails ............................................................................................... 49
Backup fails with error: Storage system(s) may need to be added, also ensure
that the associated host is in a connected state .................................................... 49
Cannot enable SAP HANA ....................................................................................... 50
Clone split estimation fails when the aggregate does not have space ....................... 50
Clone split start operation fails .................................................................................. 50
Clone split operation stops responding ..................................................................... 51
Databases on which the clone split operation was performed are listed as clones ... 51
Restore operation times out ....................................................................................... 51

Managing policies ....................................................................................... 52
Detaching policies ..................................................................................................... 52
Modifying policies .................................................................................................... 53
Deleting policies ........................................................................................................ 54

Managing resource groups ........................................................................ 55
Stopping and resuming operations on resource groups ............................................. 55
Deleting resource groups ........................................................................................... 56

Deleting SAP HANA database backups ................................................... 57
Deleting SAP HANA database clones ....................................................... 58
Copyright .................................................................................................... 59
Trademark .................................................................................................. 60
How to send comments about documentation and receive update
notifications ............................................................................................ 61
Index ............................................................................................................. 62

5

Deciding on whether to read the SnapCenter Data
Protection Guide for SAP HANA Database
This information describes how to use SnapCenter to perform backup, restore, and clone operations
on SAP HANA databases.
You should read this information if you want to use SnapCenter in the following ways:
•

You want to create data protection policies and resource groups for SAP HANA databases

•

You want to perform backup, restore, or clone operations on SAP HANA databases using the
graphical user interface (GUI)

•

You want to perform backup, restore, or clone operations on SAP HANA databases using
Windows cmdlets

You should have already performed the following tasks:
•

Installed SnapCenter Server and the SnapCenter Plug-in for SAP HANA Database

•

Configured role-based access control (RBAC), storage system connections, and credentials

•

Deployed the NetApp Data Broker virtual appliance, enabled the SnapCenter Plug-in for VMware
vSphere, and registered the plug-in with SnapCenter, if you want to protect SAP HANA
databases on virtual machines. The NetApp Data Broker, SnapCenter Plug-in for VMware
vSphere, documentation has more information.

Deployment Guide for SnapCenter Plug-in for VMware vSphere
Data Protection Guide for VMs, Datastores, and VMDKs using the SnapCenter Plug-in for
VMware vSphere
You can also use the following information to help accomplish your data protection goals:
•

SnapCenter Server and plug-in installation and setup

Installing and setting up SnapCenter
Getting Started
•

SnapCenter concepts, including architecture, features, and benefits

Concepts
•

Other SnapCenter Data Protection Guides for specific types of resources, such as Microsoft SQL
Server, Oracle, Windows file systems, and custom plug-ins

•

SnapCenter PowerShell cmdlets
SnapCenter Software 4.2 Windows Cmdlet Reference Guide

•

SnapCenter administration, including dashboards, reporting capabilities, and REST APIs, and
managing licenses, storage connections, and the SnapCenter Server repository

Performing administrative tasks
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SnapCenter Plug-in for SAP HANA Database
overview
The SnapCenter Plug-in for SAP HANA Database is a host-side component of the NetApp
SnapCenter software that enables application-aware data protection management of SAP HANA
databases. The Plug-in for SAP HANA Database automates the backup, restore, and cloning of SAP
HANA databases in your SnapCenter environment.
SnapCenter supports single container and multitenant database containers (MDC): single tenant types
of SAP HANA database.
When the Plug-in for SAP HANA Database is installed, you can use SnapCenter with NetApp
SnapMirror technology to create mirror copies of backup sets on another volume. You can also use
the plug-in with NetApp SnapVault technology to perform disk-to-disk backup replication for
standards compliance. You can use the plug-in in both Windows and Linux environments.
The Data Protection Guide for your plug-in has information about data protection operations.
The SnapCenter concepts documentation has information about the SnapCenter architecture,
features, and benefits.
Related information

Concepts
Installing and setting up SnapCenter
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Data protection workflow for SAP HANA
databases
The data protection workflow lists the tasks that you have to perform for data protection.

Related tasks

Backing up SAP HANA databases on page 12
Restoring SAP HANA databases on page 27
Cloning SAP HANA database backups on page 31
Related information

Installing and setting up SnapCenter
Concepts
Performing administrative tasks
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Preparing for data protection
Before performing any data protection operation such as backup, clone, or restore operations, you
must define your strategy and set up the environment. You can also set up the SnapCenter Server to
use SnapMirror and SnapVault technology.
To take advantage of SnapVault and SnapMirror technology, you must configure and initialize a data
protection relationship between the source and destination volumes on the storage device. You can
use NetApp System Manager or you can use the storage console command line to perform these
tasks.
Related information

Installing and setting up SnapCenter

Prerequisites for using the SnapCenter Plug-in for SAP
HANA Database
Before you use SnapCenter Plug-in for SAP HANA Database, the SnapCenter administrator must
install and configure the SnapCenter Server and perform the prerequisite tasks.
•

Install and configure SnapCenter Server.

•

Log in to SnapCenter Server.

•

If you are using SnapCenter Server to protect SAP HANA databases that reside on VMware
RDM LUNs or VMDKs, you must deploy the NetApp Data Broker virtual appliance, enable the
SnapCenter Plug-in for VMware vSphere, and register the plug-in with SnapCenter. See the
NetApp Data Broker, SnapCenter Plug-in for VMware vSphere, documentation.

Deployment Guide for SnapCenter Plug-in for VMware vSphere
Data Protection Guide for VMs, Datastores, and VMDKs using the SnapCenter Plug-in for
VMware vSphere
•

Configure the SnapCenter environment by adding storage system connections and creating
credentials, if applicable.

•

Add hosts, and then install and upload the plug-ins.

•

Install Java 1.7 or Java 1.8 on your Linux or Windows host.
You must set the Java path in the environmental path variable of the host machine.

•

Set up SnapMirror and SnapVault, if you want backup replication.

•

Install the HDBSQL client on the host where you will install the Plug-in for SAP HANA
Database.
Configure the user store keys for the SAP HANA nodes that you will manage through this host.

Related information

Installing and setting up SnapCenter
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Storage types supported by SnapCenter Plug-in for SAP
HANA Database
SnapCenter supports a wide range of storage types on both physical machines and virtual machines
(VMs). You must verify the support for your storage type before installing SnapCenter Plug-in for
SAP HANA Database.
Machine

Storage type

Physical and virtual servers

FC-connected LUNs
NFS-connected volumes

How resources, resource groups, and policies are used in
data protection of SAP HANA databases
Before you use SnapCenter, it is helpful to understand basic concepts related to the backup, clone,
and restore operations you want to perform. You interact with resources, resource groups, and
policies for different operations.
•

Resources are typically SAP HANA databases that you back up or clone with SnapCenter.

•

A SnapCenter resource group is a collection of resources on a host or cluster.
When you perform an operation on a resource group, you perform that operation on the resources
defined in the resource group according to the schedule you specify for the resource group.
You can back up on demand a single resource or a resource group. You also can perform
scheduled backups for single resources and resource groups.

•

The policies specify the backup frequency, copy retention, replication, scripts, and other
characteristics of data protection operations.
When you create a resource group, you select one or more policies for that group. You can also
select a policy when you perform a backup on demand for a single resource.

Think of a resource group as defining what you want to protect and when you want to protect it in
terms of day and time. Think of a policy as defining how you want to protect it. If you are backing up
all databases, for example, you might create a resource group that includes all of the databases in the
host. You could then attach two policies to the resource group: a daily policy and an hourly policy.
When you create the resource group and attach the policies, you might configure the resource group
to perform a full backup daily.
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Logging in to SnapCenter
SnapCenter supports role-based access control (RBAC). SnapCenter admin assigns roles and
resources through SnapCenter RBAC to either a user in workgroup or active directory, or to groups in
active directory. The RBAC user can now log in to SnapCenter with the assigned roles.
Before you begin

•

You should enable Windows Process Activation Service (WAS) in Windows Server Manager.

•

If you want to use Internet Explorer as the browser to log in to the SnapCenter Server, you should
ensure that the Protected Mode in Internet Explorer is disabled.

About this task

During installation, the SnapCenter Server Install wizard creates a shortcut and places it on the
desktop and in the Start menu of the host where SnapCenter is installed. Additionally, at the end of
the installation, the Install wizard displays the SnapCenter URL based on the information that you
provided during installation, which you can copy if you want to log in from a remote system.
Attention: If you have multiple tabs open in your web browser, closing just the SnapCenter

browser tab does not log you out of SnapCenter. To end your connection with SnapCenter, you
must log out of SnapCenter either by clicking the Sign out button, or by closing the entire web
browser.
Best Practice: For security reasons, it is recommended that you do not enable your browser to

save your SnapCenter password.
The default GUI URL is a secure connection to the default port 8146 on the server where the
SnapCenter Server is installed (https://server:8146). If you provided a different server port
during the SnapCenter installation, that port is used instead.
For Network Load Balance (NLB) deployment, you must access SnapCenter using the NLB cluster
IP (https://NLB_Cluster_IP:8146). If you do not see the SnapCenter UI when you navigate to
https://NLB_Cluster_IP:8146 in Internet Explorer (IE), you must add the NLB IP address as a
trusted site in IE on each plug-in host, or you must disable IE Enhanced Security on each plug-in
host.

NetApp KB Article 2025082: SnapCenter in an HA configuration with Application Request Routing
enabled.
In addition to using the SnapCenter GUI, you can use PowerShell cmdlets to create scripts to perform
configuration, backup, and restore operations. Some cmdlets might have changed with each
SnapCenter release. The SnapCenter cmdlet or SnapCenter CLI documentation has the details.
Note: If you are logging in to SnapCenter for the first time, you must log in using the credentials
that you provided during the install process.
Steps

1. Launch SnapCenter from the shortcut located on your local host desktop, or from the URL
provided at the end of the installation, or from the URL provided by your SnapCenter
administrator.
2. Enter user credentials.
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To specify the following...

Use one of these formats...

Domain administrator

NetBIOS\UserName
UserName@UPN suffix

For example, username@netapp.com
Domain FQDN\UserName

Local administrator

UserName

3. If you are assigned more than one role, from the Role box, select the role that you want to use for
this login session.
Your current user and associated role are shown in the upper right of SnapCenter after you are
logged in.
Result

If you are using SnapCenter for the first time, the Storage Systems page is displayed, and the Get
Started pane is expanded.
If the logging fails with the error that site cannot be reached, you should map the SSL certificate to
SnapCenter.
After logging to SnapCenter Server for the first time, the SnapCenter Server Configuration Checker
schedule is created. The default values are Weekly and Every Sunday at 11:59 pm. To modify the
schedule or run the SnapCenter Server schedule, click Settings > Scheduled Configuration
Checker.
After you finish

If you have untrusted Active Directory domains that you want SnapCenter to support, you must
register those domains with SnapCenter before configuring the roles for the users on untrusted
domains. The administration documentation has more details.

Performing administrative tasks
Related information

SnapCenter Software 4.2 Windows Cmdlet Reference Guide
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Backing up SAP HANA databases
You can either create a backup of a resource (database) or resource group. The backup workflow
includes planning, identifying the databases for backup, managing backup policies, creating resource
groups and attaching policies, creating backups, and monitoring the operations.
About this task

The following workflow shows the sequence in which you must perform the backup operation:

You can also use PowerShell cmdlets manually or in scripts to perform backup, restore, and clone
operations. The SnapCenter cmdlet help and the cmdlet reference information contain more
information about PowerShell cmdlets.
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Adding databases to SnapCenter Plug-in for SAP HANA
Database
You must add the databases that you want to back up or clone.
Before you begin

You must have completed tasks such as installing the SnapCenter Server, adding hosts, creating
storage system connections, and adding credentials.
Steps

1. In the left navigation pane, select the appropriate plug-in from the drop-down list, and then click
Resources.
2. In the Resources page, click Add SAP HANA Database.
3. In the Provide Resource Details page, perform the following actions:
For this field...

Do this...

Resource Type

Enter the resource type.
Resource types are Single Container, Multitenant Database
Containers (MDC) – Single Tenant, and Non-data Volumes.

SAP HANA System
Name

Enter the descriptive SAP HANA system name.

SID

Enter the system ID (SID).
The installed SAP HANA system is identified by a single SID.

Tenant Database

Enter the name of the tenant database for SAP HANA databases.
This option is available only if you selected the Multitenant Database
Containers (MDC) – Single Tenant resource type.

HDBSQL Client Host

Select the communication host.

HDB Secure User
Store Keys

Enter the key to connect to the SAP HANA system.
The key contains the login information to connect to the database.

HDBSQL OS User

Enter the user name for whom the HDB Secure User Store Key is
configured.
For Windows, it is mandatory for the HDBSQL OS User to be the
SYSTEM user. Therefore, you must configure the HDB Secure User
Store Key for the SYSTEM user.

Resource Name

Enter the resource name.
This option is available only if you selected the Non-data Volumes.
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4. In the Provide Storage Footprint page, select a storage system and choose one or more volumes,
LUNs, and qtrees, and then click Save.
Optional: You can click the
storage systems.

icon to add more volumes, LUNs, and qtrees from other

Note: SnapCenter Plug-in for SAP HANA Database does not support automatic discovery of
the resources and storage details for physical and virtual environments. You must provide the
storage information for physical and virtual environments while adding the databases.

5. In the Resource Settings page, perform the following actions:
For this field...

Do this...

Prefix

Enter the prefix of the File-Based backup name.
If the prefix is not provided, the default value is used.

Location

Enter the path on the SAP HANA node to save the File-Based
backup.
If the path is not provided, SAP HANA uses the default path
configured on the system, for example, HANA shared path/
<SID>/HDBINSTANCE_ID/backup/data.

6. Review the summary, and then click Finish.
The databases are displayed along with information such as the SID, Tenant Database for MDC,
communication host, associated resource groups and policies, and overall status.
After you finish

If you want to provide users access to resources, you must assign the resources to the users. This
enables users to perform the actions for which they have permissions on the assets that are assigned
to them.
After adding the databases, you can modify the SAP HANA database details.
You cannot modify the following if the SAP HANA database has backups associated with it:
•

Multitenant database containers (MDC): SID, Tenant Database, or HDBSQL Client Host
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•

Single Container: SID or HDBSQL Client Host

•

NonDataVolume: Resource name, Associated SID, or Plug-in Host

Related information

Performing administrative tasks

Creating backup policies for SAP HANA databases
Before you use SnapCenter to back up SAP HANA database resources, you must create a backup
policy for the resource or resource group that you want to back up. A backup policy is a set of rules
that governs how you manage, schedule, and retain backups.
Before you begin

•

You must have defined your backup strategy.
For details, see the information about defining a data protection strategy for SAP HANA
databases.

Concepts
•

You must have prepared for data protection by completing tasks such as installing SnapCenter,
adding hosts, setting up storage system connections, and adding resources.

•

The SnapCenter administrator must have assigned the SVMs for both the source and destination
volumes to you if you are replicating Snapshot copies to a mirror or vault.

About this task

Additionally, you can specify replication, script, and application settings in the policy. These options
saves time when you want to reuse the policy for another resource group.
Steps

1. In the left navigation pane, click Settings.
2. In the Settings page, click Policies.
3. Click New.
4. In the Name page, enter the policy name and description.
5. In the Settings page, perform the following steps:
•

•

Choose backup type:
If you want to...

Do this...

Perform an integrity
check of the database

Select File-Based Backup.

Create a backup using
Snapshot copy
technology

Select Snapshot Based.

Specify the schedule type by selecting Hourly, Daily, Weekly, or Monthly.
Note: You can specify the schedule (start date, end date, and frequency) for the backup
operation while creating a resource group. This enables you to create resource groups that
share the same policy and backup frequency, but also enables you to assign different backup
schedules to each policy.
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•

In the Custom backup settings section, provide any specific backup settings that have to be
passed to the plug-in in key-value format.
You can provide multiple key-values to be passed to the plug-in.

6. In the Retention page, specify the retention settings for the backup type and the schedule type
selected in the Backup Type page:
If you want to...

Then...

Keep a certain number of
Snapshot copies

Select Total Snapshot copies to keep, and then specify the number of
Snapshot copies that you want to keep.
If the number of Snapshot copies exceeds the specified number, the
Snapshot copies are deleted with the oldest copies deleted first.
Note: The maximum retention value is 1018 for resources on ONTAP
9.4 or later, and 254 for resources on ONTAP 9.3 or earlier. Backups
will fail if retention is set to a value higher than what the underlying
ONTAP version supports.
Important: For Snapshot copy-based backups, you must set the
retention count to 2 or higher if you plan to enable SnapVault
replication. If you set the retention count to 1, the retention operation
might fail because the first Snapshot copy is the reference Snapshot
copy for the SnapVault relationship until a newer Snapshot copy is
replicated to the target.
If you use the file-based backup to execute an integrity check, you
must set the retention count to 1. This enables each of the block
integrity checks to overwrite the backup that was created before, and
retain only one file-based backup.

Keep the Snapshot copies for
a certain number of days

Select Keep Snapshot copies for, and then specify the number of days
for which you want to keep the Snapshot copies before deleting them.

7. For Snapshot copy-based backups, specify the replication settings in the Replication page:
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For this field...

Do this...

Update SnapMirror
after creating a local
Snapshot copy

Select this field to create mirror copies of the backup sets on
another volume (SnapMirror replication).
If the protection relationship in ONTAP is of type Mirror and
Vault and if you select only this option, the Snapshot copy created
on the primary will not be transferred to the destination, but will
be listed in the destination. If this Snapshot copy is selected from
the destination to perform a restore operation, then the
Secondary Location is not available for the
selected vaulted/mirrored backup error message is

displayed.
Update SnapVault after
creating a local
Snapshot copy

Select this option to perform disk-to-disk backup replication
(SnapVault backups).

Secondary policy label

Select a Snapshot label.
Depending on the Snapshot label that you select, the ONTAP
software applies the secondary Snapshot copy retention policy that
determines how Snapshot copies are retained on the secondary
storage system.

Error retry count

Enter the maximum number of replication attempts that can be
allowed before the operation stops.

8. Review the summary, and then click Finish.
Related information

SnapCenter Software 4.2 Windows Cmdlet Reference Guide

Creating resource groups and attaching policies
A resource group is the container to which you must add resources that you want to back up and
protect. A resource group enables you to back up all the data that is associated with a given
application simultaneously. A resource group is required for any data protection job. You must also
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attach one or more policies to the resource group to define the type of data protection job that you
want to perform.
Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, click New Resource Group.
3. In the Name page, perform the following actions:
For this field...

Do this...

Name

Enter a name for the resource group.

Tags

Enter one or more labels that will help you
later search for the resource group.
For example, if you add HR as a tag to
multiple resource groups, you can later find
all resource groups associated with the HR
tag.

Use custom name format for Snapshot copy

Select this check box, and enter a custom
name format that you want to use for the
Snapshot copy name.
For example, customtext_resource
group_policy_hostname or resource
group_hostname. By default, a timestamp is
appended to the Snapshot copy name.

4. Optional: In the Resources page, select a host name from the Host drop-down list and resource
type from the Resource Type drop-down list.
This helps to filter information on the screen.
5. Select the resources from the Available Resources section, and then click the right arrow to move
them to the Selected Resources section.
6. Optional: In the Application Settings page, do the following:
•

Click the Backups arrow to set additional backup options:
Enable consistency group backup and perform the following tasks:
For this field...

Do this...

Afford time to wait for Consistency Group
Snapshot operation to complete

Select Urgent, Medium, or Relaxed to
specify the wait time for Snapshot copy
operation to complete. Urgent = 5 seconds,
Medium = 7 seconds, and Relaxed = 20
seconds.

Disable WAFL Sync

Select this to avoid forcing a WAFL
consistency point.
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•

Click the Scripts arrow and enter the pre and post commands for quiesce, Snapshot copy, and
unquiesce operations. You can also enter the pre commands to be executed before exiting in
the event of a failure.

•

Click the Custom Configurations arrow and enter the custom key-value pairs required for all
data protection operations using this resource.

•

Click the Snapshot Copy Tool arrow to select the tool to create Snapshot copies:
If you want...

Then...

SnapCenter to use the plug-in for Windows
and put the file system into a consistent state
before creating a Snapshot copy. For Linux
resources, this option is not applicable.

Select SnapCenter with File System
Consistency.
This option is not applicable for SnapCenter
Plug-in for SAP HANA Database.

SnapCenter to create a storage level
Snapshot copy

Select SnapCenter without File System
Consistency.

To enter the command to be executed on the
host to create Snapshot copies.

Select Other, and then enter the command
to be executed on the host to create a
Snapshot copy.

7. In the Policies page, perform the following steps:
a. Select one or more policies from the drop-down list.
Note: You can also create a policy by clicking

.

The policies are listed in the Configure schedules for selected policies section.
b. In the Configure Schedules column, click

for the policy you want to configure.

c. In the Add schedules for policy policy_name dialog box, configure the schedule, and then
click OK.
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Where, policy_name is the name of the policy that you have selected.
The configured schedules are listed in the Applied Schedules column.
8. In the Notification page, from the Email preference drop-down list, select the scenarios in which
you want to send the emails.
You must also specify the sender and receiver email addresses, and the subject of the email. The
SMTP server must be configured in Settings > Global Settings.
9. Review the summary and click Finish.
Related tasks

Creating backup policies for SAP HANA databases on page 15

Backing up SAP HANA databases
If a resource is not yet part of any resource group, you can back up the resource from the Resources
page.
Before you begin

•

You must have created a backup policy.

•

If you want to back up a resource that has a SnapMirror relationship with a secondary storage, the
role assigned to the storage user should include the “snapmirror all” privilege. However, if you
are using the “vsadmin” role, then the “snapmirror all” privilege is not required.

Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. Optional: In the Resource page, filter resources from the View drop-down list based on resource
type.
Click

, and then select the host name and the resource type to filter the resources. You can then

click

to close the filter pane.

3. Click the resource that you want to back up.
4. In the Resource page, select Use custom name format for Snapshot copy, and then enter a
custom name format that you want to use for the Snapshot copy name.
Example

For example, customtext__policy_hostname or resource_hostname. By default, a
timestamp is appended to the Snapshot copy name.
5. Optional: In the Application Settings page, do the following:
•

Click the Backups arrow to set additional backup options:
Enable consistency group backup, if needed, and perform the following tasks:
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For this field...

Do this...

Afford time to wait for “Consistency Group
Snapshot” operation to complete

Select Urgent, or Medium, or Relaxed to
specify the wait time for Snapshot copy
operation to finish. Urgent = 5 seconds,
Medium = 7 seconds, and Relaxed = 20
seconds.

Disable WAFL Sync

Select this to avoid forcing a WAFL
consistency point.

•

Click the Scripts arrow to run pre and post commands for quiesce, Snapshot copy, and
unquiesce operations.
You can also run pre commands before exiting the backup operation. Prescripts and
postscripts are run in the SnapCenter Server.

•

Click the Custom Configurations arrow, and then enter the custom value pairs required for
all jobs using this resource.

•

Click the Snapshot Copy Tool arrow to select the tool to create Snapshot copies:
If you want...

Then...

SnapCenter to create a storage-level
Snapshot copy

Select SnapCenter without File System
Consistency.

SnapCenter to use the plug-in for Windows
to put the file system into a consistent state
and then create a Snapshot copy

Select SnapCenter with File System
Consistency.

To enter the command to create a Snapshot
copy

Select Other, and then enter the command
to create a Snapshot copy.

6. In the Policies page, perform the following steps:
a. Select one or more policies from the drop-down list.
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Note: You can also create a policy by clicking

.

In the Configure schedules for selected policies section, the selected policies are listed.
b. Click
in the Configure Schedules column for the policy for which you want to
configure a schedule.
c. In the Add schedules for policy policy_name dialog box, configure the schedule, and then
click OK.
policy_name is the name of the policy that you selected.

The configured schedules are listed in the Applied Schedules column.
7. In the Notification page, from the Email preference drop-down list, select the scenarios in which
you want to send the emails.
You must also specify the sender and receiver email addresses, and the subject of the email.
SMTP must also be configured in Settings > Global Settings.
8. Review the summary, and then click Finish.
The resources topology page is displayed.
9. Click Back up Now.
10. In the Backup page, perform the following steps:
a. If you applied multiple policies to the resource, from the Policy drop-down list, select the
policy that you want to use for backup.
b. Click Backup.
11. Monitor the operation progress by clicking Monitor > Jobs.
Related tasks

Creating backup policies for SAP HANA databases on page 15
Monitoring backup operations on page 23
Viewing SAP HANA database backups and clones in the Topology page on page 25
Backing up databases using PowerShell cmdlets on page 38

Backing up resource groups
A resource group is a collection of resources on a host or cluster. A backup operation on the resource
group is performed on all resources defined in the resource group.
Before you begin

•

You must have created a resource group with a policy attached.

•

If you want to back up a resource that has a SnapMirror relationship with a secondary storage, the
role assigned to the storage user should include the “snapmirror all” privilege. However, if you
are using the “vsadmin” role, then the “snapmirror all” privilege is not required.
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About this task

You can back up a resource group on demand from the Resources page. If a resource group has a
policy attached and a schedule configured, then backups occur automatically according to the
schedule.
Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, select Resource Group from the View list.
You can search the resource group either by entering the resource group name in the search box
or by clicking

, and then selecting the tag. You can then click

to close the filter pane.

3. In the Resource Groups page, select the resource group that you want to back up, and then click
Back up Now.
4. In the Backup page, perform the following steps:
a. If you associated multiple policies with the resource group, from the Policy drop-down list,
select the policy that you want to use for backup.
b. Click Backup.
5. Monitor the operation progress by clicking Monitor > Jobs.
Related tasks

Creating resource groups and attaching policies on page 17
Creating backup policies for SAP HANA databases on page 15
Monitoring backup operations on page 23
Viewing SAP HANA database backups and clones in the Topology page on page 25
Backing up databases using PowerShell cmdlets on page 38

Monitoring backup operations
You can monitor the progress of different backup operations by using the SnapCenter Jobs page. You
might want to check the progress to determine when it is complete or if there is an issue.
About this task

The following icons appear on the Jobs page and indicate the state of the operation:
•

In progress

•

Completed successfully

•

Failed

•

Completed with warnings or could not start due to warnings

•

Queued

•

Canceled
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Steps

1. In the left navigation pane, click Monitor.
2. In the Monitor page, click Jobs.
3. Optional: In the Jobs page, perform the following steps:
a. Click

to filter the list so that only backup operations are listed.

b. Specify the start and end dates.
c. From the Type drop-down list, select Backup.
d. From the Status drop-down, select the backup status.
e. Click Apply to view the operations completed successfully.
4. Select a backup job, and then click Details to view the job details.
Note: Though the backup job status displays
, when you click on job details you might see
that some of the child tasks of the backup operation are still in progress.

5. Optional: In the Job Details page, click View logs.
The View logs button displays the detailed logs for the selected operation.

Monitoring operations in the Activity pane
The Activity pane displays the five most recent operations performed. The Activity pane also
displays when the operation was initiated and the status of the operation.
About this task

The Activity pane displays information regarding backup, restore, clone, and scheduled backup
operations.
Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. Click

on the Activity pane to view the five most recent operations.

When you click one of the operations, the operation details are listed in the Job Details page.

Canceling the backup operations
You can cancel backup operations that are queued.
Before you begin

•

You must be logged in as the SnapCenter Admin or job owner to cancel operations.

About this task

•

You can cancel a backup operation from either the Monitor page or the Activity pane.

•

You can use the SnapCenter GUI, PowerShell cmdlets, or CLI commands to cancel the backup
operations.

•

The Cancel Job button is disabled for operations that cannot be canceled.
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•

If you selected All members of this role can see and operate on other members objects in
Users\Groups page while creating a role, you can cancel the queued backup operations of other
members while using that role.

Step

1. Perform one of the following actions:
From the…
Monitor page

Action
a. In the left navigation pane, click Monitor
> Jobs.
b. Select the operation, and click Cancel
Job.

Activity pane

a. After initiating the backup operation, click
on the Activity pane to view the five
most recent operations.
b. Select the operation.
c. In the Job Details page, click Cancel Job.

Result

The operation is canceled, and the resource is reverted to the previous state.
Related information

SnapCenter Software 4.2 Windows Cmdlet Reference Guide

Viewing SAP HANA database backups and clones in the
Topology page
When you are preparing to back up or clone a resource, you might find it helpful to view a graphical
representation of all backups and clones on the primary and secondary storage.
About this task

You can review the following icons in the Manage Copies view to determine whether the backups
and clones are available on the primary or secondary storage (Mirror copies or Vault copies).

•

displays the number of backups and clones that are available on the primary storage.

•

displays the number of backups and clones that are mirrored on the secondary storage
using SnapMirror technology.

•

displays the number of backups and clones that are replicated on the secondary storage
using SnapVault technology.
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Note: The number of backups displayed includes the backups deleted from the secondary
storage. For example, if you created 6 backups using a policy to retain only 4 backups, the
number of backups displayed is 6.
Note: Clones of a backup of a version-flexible mirror on a mirror-vault type volume are displayed
in the topology view, but the mirror backup count in the topology view does not include the
version-flexible backup.
In the Topology page, you can see all of the backups and clones that are available for the selected
resource or resource group. You can view the details of those backups and clones, and then select
them to perform data protection operations.
Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, either select the resource or resource group from the View drop-down list.
3. Select the resource either from the resource details view or from the resource group details view.
If the resource is protected, the topology page of the selected resource is displayed.
4. Review the Summary card to see a summary of the number of backups and clones available on
the primary and secondary storage.
The Summary Card section displays the total number of File-Based backups, Snapshot copy
backups, and clones.
Clicking the Refresh button starts a query of the storage to display an accurate count.
5. In the Manage Copies view, click Backups or Clones from the primary or secondary storage to
see details of a backup or clone.
The details of the backups and clones are displayed in a table format.
6. Select the backup from the table, and then click the data protection icons to perform restore,
clone, and delete operations.
Note: You cannot rename or delete backups that are on the secondary storage.

7. If you want to delete a clone, select the clone from the table, and then click

.
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Restoring SAP HANA databases
The restore and recovery workflow includes planning, performing the restore operations, and
monitoring the operations.
About this task

The following workflow shows the sequence in which you must perform the restore operation:

You can also use PowerShell cmdlets manually or in scripts to perform backup, restore, and clone
operations. The SnapCenter cmdlet help and the cmdlet reference information contain detailed
information about PowerShell cmdlets.
Related tasks

Restoring SAP HANA database using PowerShell cmdlets on page 41
Related information
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Restoring a database backup
You can use SnapCenter to restore data from one or more backups.
Before you begin

•

You must have backed up the resource or resource groups.

•

The SnapCenter administrator must have assigned you the storage virtual machines (SVMs) for
both the source volumes and destination volumes if you are replicating Snapshot copies to a
mirror or vault.

•

You must have canceled any backup operation that is currently in progress for the resource or
resource group that you want to restore.

About this task

File-based backup copies cannot be restored from SnapCenter.
Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
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2. In the Resources page, filter resources from the View drop-down list based on resource type.
The resources are displayed along with information such as type, host or cluster name, associated
resource groups and policies, and status.
Note: Although a backup might be for a resource group, when you restore, you must select the
individual resources you want to restore.

If the resource is not protected, Not protected is displayed in the Overall Status column.
This can mean either that the resource is not protected, or that the resource was backed up by a
different user.
3. Select the resource, or select a resource group and then select a resource in that group.
The resource topology page is displayed.
4. From the Manage Copies view, select Backups either from the primary or secondary (mirrored
or vaulted) storage systems.
5. In the Primary backup(s) table, select the backup that you want to restore from, and then click
.

6. In the Restore Scope page, select either Complete Resource or File Level.
a. If you select Complete Resource, all of the configured data volumes of the SAP HANA
database are restored.
If the resource contains volumes or qtrees as Storage Footprint, then newer Snapshot copies
on such volumes or qtrees are deleted and cannot be recovered. Also, if any other resource is
hosted on same volumes or qtrees, then that resource is also deleted.
b. If you select File Level, then you can either select All or select the specific volumes or qtrees,
and then enter the path related to those volumes or qtrees, separated by commas
•

You can select multiple volumes and qtrees.

•

If the resource type is LUN, the entire LUN is restored.
You can select multiple LUNs.
Note: If you select All, all the files on the volumes, qtrees, or LUNs are restored.

7. Optional: In the Pre ops page, enter pre restore and unmount commands to run before performing
a restore job.
8. Optional: In the Post ops page, enter mount and post restore commands to run after performing a
restore job.
9. In the Notification page, from the Email preference drop-down list, select the scenarios in which
you want to send the emails.
You must also specify the sender and receiver email addresses, and the subject of the email.
SMTP must also be configured in the Settings > Global Settings page.
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10. Review the summary, and then click Finish.
11. Monitor the operation progress by clicking Monitor > Jobs.
Related tasks

Restoring SAP HANA database using PowerShell cmdlets on page 41

Monitoring restore operations
You can monitor the progress of different SnapCenter restore operations by using the Jobs page. You
might want to check the progress of an operation to determine when it is complete or if there is an
issue.
About this task

Post-restore states describe the conditions of the resource after a restore operation and any further
restore actions that you can take.
The following icons appear on the Jobs page, and indicate the state of the operation:
•

In progress

•

Completed successfully

•

Failed

•

Completed with warnings or could not start due to warnings

•

Queued

•

Canceled

Steps

1. In the left navigation pane, click Monitor.
2. In the Monitor page, click Jobs.
3. Optional: In the Jobs page, perform the following steps:
a. Click

to filter the list so that only restore operations are listed.

b. Optional: Specify the start and end dates.
c. From the Type drop-down list, select Restore.
d. From the Status drop-down list, select the restore status.
e. Click Apply to view the operations that are completed successfully.
4. Select the restore job, and then click Details to view the job details.
5. Optional: In the Job Details page, click View logs.
The View logs button displays the detailed logs for the selected operation.
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Canceling restore operations
You can cancel restore jobs that are queued.
Before you begin

•

You must be logged in as the SnapCenter Admin or job owner to cancel restore operations.

About this task

•

You can cancel a restore operation from either the Monitor page or the Activity pane.

•

You cannot cancel a running restore operation.

•

You can use the SnapCenter GUI, PowerShell cmdlets, or CLI commands to cancel the restore
operations.

•

The Cancel Job button is disabled for restore operations that cannot be canceled.

•

If you selected All members of this role can see and operate on other members objects in
Users\Groups page while creating a role, you can cancel the queued backup operations of other
members while using that role.

Step

1. Perform one of the following actions:
From the…
Monitor page

Action
a. In the left navigation pane, click Monitor
> Jobs.
b. Select the job and click Cancel Job.

Activity pane

a. After initiating the restore operation, click
on the Activity pane to view the five
most recent operations.
b. Select the operation.
c. In the Job Details page, click Cancel Job.

Related information

SnapCenter Software 4.2 Windows Cmdlet Reference Guide
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Cloning SAP HANA database backups
The clone workflow includes performing the clone operation and monitoring the operation.
About this task

You might clone resource backups for the following reasons:
•

To test functionality that has to be implemented using the current resource structure and content
during application development cycles

•

For data extraction and manipulation tools when populating data warehouses

•

To recover data that was mistakenly deleted or changed

The following workflow shows the sequence in which you must perform the clone operation:

You can also use PowerShell cmdlets manually or in scripts to perform backup, restore, and clone
operations. The SnapCenter cmdlet help and the cmdlet reference information contain detailed
information about PowerShell cmdlets.
Related tasks

Cloning SAP HANA database backups using PowerShell cmdlets on page 43
Related information
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Cloning a SAP HANA database backup
You can use SnapCenter to clone a backup. You can clone from primary or secondary backup.
Before you begin

You must have backed up the resources or resource group.
About this task

•

You cannot clone file-based backups.
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Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, filter resources from the View drop-down list based on resource type.
The resources are displayed along with information such as type, host or cluster name, associated
resource groups and policies, and status.
3. Select the resource or resource group.
You must select a resource if you select a resource group.
The resource or resource group topology page is displayed.
4. From the Manage Copies view, select Backups either from the primary or secondary (mirrored
or vaulted) storage systems.
5. Select the data backup from the table, and then click

.

6. In the Location page, perform the following actions:
For this field...

Do this...

Clone server

Select the host on which the clone should be mounted and the plug-in
is installed.

NFS Export IP
Address

Enter IP addresses or the host names on which the cloned volumes
will be exported.

iSCSI Initiator

Enter iSCSI initiator name of the host to which the LUNs are
exported.
This option is available only if you selected LUN resource type.

Protocol

Enter the LUN protocol.
This option is available only if you selected LUN resource type.

If the resource selected is a LUN and you are cloning from a secondary backup, then the
destination volumes are listed. A single source can have multiple destination volumes.
7. Optional: In the Scripts page, perform the following steps: .
a. Enter the commands for pre clone or post clone that should be run before or after the clone
operation, respectively.
Example

•

Pre clone command: delete existing databases with the same name

•

Post clone command: verify a database or start a database.

b. Enter the mount command to mount a file system to a host.
Example

Mount command for a volume or qtree on a Linux machine:
mount VSERVER_DATA_IP:${VOLUME_NAME_Clone} /mnt
8. In the Notification page, from the Email preference drop-down list, select the scenarios in which
you want to send the emails.
You must also specify the sender and receiver email addresses, and the subject of the email.
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9. Review the summary, and then click Finish.
10. Monitor the operation progress by clicking Monitor > Jobs.
Related tasks

Cloning SAP HANA database backups using PowerShell cmdlets on page 43
Viewing SAP HANA database backups and clones in the Topology page on page 25

Monitoring clone operations from the Jobs page
You can monitor the progress of SnapCenter clone operations by using the Jobs page. You might
want to check the progress of an operation to determine when it is complete or if there is an issue.
About this task

The following icons appear on the Jobs page, and indicate the state of the operation:
•

In progress

•

Completed successfully

•

Failed

•

Completed with warnings or could not start due to warnings

•

Queued

Steps

1. In the left navigation pane, click Monitor.
2. In the Monitor page, click Jobs.
3. Optional: In the Jobs page, perform the following steps:
a. Click

to filter the list so that only clone operations are listed.

b. Specify the start and end dates.
c. From the Type drop-down list, select Clone.
d. From the Status drop-down list, select the clone status.
e. Click

to view the operations that are completed successfully.

4. Select the clone job, and then click Details to view the job details.
5. Optional: In the Job Details page, click View logs.
The View logs button displays the detailed logs for the selected operation.
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Canceling clone operations
You can cancel clone operations that are queued.
Before you begin

•

You must be logged in as the SnapCenter Admin or job owner to cancel operations.

About this task

•

You can cancel a clone operation from either the Monitor page or the Activity pane.

•

You cannot cancel a running clone operation.

•

You can use the SnapCenter GUI, PowerShell cmdlets, or CLI commands to cancel the clone
operations.

•

If you selected All members of this role can see and operate on other members objects in
Users\Groups page while creating a role, you can cancel the queued backup operations of other
members while using that role.

Step

1. Perform one of the following actions:
From the…
Monitor page

Action
a. In the left navigation pane, click Monitor
> Jobs.
b. Select the operation, and click Cancel
Job.

Activity pane

a. After initiating the clone operation, click
on the Activity pane to view the five
most recent operations.
b. Select the operation.
c. In the Job Details page, click Cancel Job.

Related information
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Splitting a clone
You can use SnapCenter to split a cloned resource from the parent resource. The clone that is split
becomes independent of the parent resource.
About this task

•

You cannot perform the clone split operation on an intermediate clone.
For example, after you create clone1 from a database backup, you can create a backup of clone1,
and then clone this backup (clone2). After you create clone2, clone1 is an intermediate clone, and
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you cannot perform the clone split operation on clone1. However, you can perform the clone split
operation on clone2.
After splitting clone2, you can perform the clone split operation on clone1 because clone1 is no
longer the intermediate clone.
•

When you split a clone, the backup copies and clone jobs of the clone are deleted.

•

For information about clone split operation limitations, see the Logical Storage Management
Guide.

ONTAP 9 Logical Storage Management Guide
Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, select the appropriate option from the View list:
Option

Description

For database applications

Select Database from the View list.

For file systems

Select Path from the View list.

3. Select the cloned resource (for example, the database or LUN), and then click

.

4. Review the estimated size of the clone that is to be split and the required space available on the
aggregate, and then click Start.
5. Monitor the operation progress by clicking Monitor > Jobs.
After you finish

If you want a longer poll time or shorter poll time to check whether the clone is split or not, you can
change the value of CloneSplitStatusCheckPollTime parameter in
SMCoreServiceHost.exe.config file to set the time interval for SMCore to poll for the status of
the clone split operation. The value is in milliseconds and the default value is 5 minutes.
For example:
<add key="CloneSplitStatusCheckPollTime" value="300000" />
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Backing up, restoring, and cloning using
PowerShell cmdlets
With SnapCenter Plug-in for SAP HANA Database, you can use PowerShell cmdlets for scripting of
backup, restore, and clone operations.
The following are common tasks you might perform using PowerShell cmdlets:
•

Creating a storage system connection and a credential

•

Backing up resources

•

Restoring backups

•

Cloning backups

The information regarding the parameters that can be used with the cmdlet and their descriptions can
be obtained by runningGet-Help command_name. Alternatively, you can also refer to the Cmdlet
Reference Guide.
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Related information
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Creating a storage system connection and a credential
using PowerShell cmdlets for SAP HANA database
You must create a storage virtual machine (SVM) connection and a credential before using
PowerShell cmdlets to back up, restore, or clone SAP HANA databases.
Before you begin

•

You should have prepared the PowerShell environment to execute the PowerShell cmdlets.

•

You should have the required permissions in the Infrastructure Admin role to create storage
connections.

•

You should ensure that the plug-in installations are not in progress.
Host plug-in installations must not be in progress while adding a storage system connection
because the host cache might not be updated and databases status might be displayed in the
SnapCenter GUI as “Not available for backup” or “Not on NetApp storage”.

•

Storage system names should be unique.
SnapCenter does not support multiple storage systems with the same name on different clusters.
Each storage system that is supported by SnapCenter should have a unique name and a unique
data LIF IP address.

About this task

The information regarding the parameters that can be used with the cmdlet and their descriptions can
be obtained by runningGet-Help command_name. Alternatively, you can also refer to the Cmdlet
Reference Guide.

SnapCenter Software 4.2 Windows Cmdlet Reference Guide
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Steps

1. Initiate a PowerShell connection session by using the Open-SmConnection cmdlet.
Example
PS C:\> Open-SmStorageConnection

2. Create a new connection to the storage system by using the Add-SmStorageConnection
cmdlet.
Example
PS C:\> Add-SmStorageConnection -Storage test_vs1 -Protocol Https
-Timeout 60

3. Create a new credential by using the Add-SmCredential cmdlet.
Example

This example shows how to create a new credential named FinanceAdmin with Windows
credentials:
PS C:> Add-SmCredential -Name FinanceAdmin -AuthMode Windows
-Credential sddev\administrator

4. Add the SAP HANA communication host to SnapCenter Server.
Example
PS C:> Add-SmHost -HostName 10.232.204.61 -OSType Windows -RunAsName
FinanceAdmin -PluginCode hana

5. Install the package and the SnapCenter Plug-in for SAP HANA Database on the host.
For Linux:
Example
PS C:> Install-SmHostPackage -HostNames 10.232.204.61 ApplicationCode hana

For Windows:
Example
Install-SmHostPackage -HostNames 10.232.204.61 -ApplicationCode hana FilesystemCode scw -RunAsName FinanceAdmin

6. Set the path to the HDBSQL client.
For Windows:
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Example
PS C:> Set-SmConfigSettings -Plugin -HostName 10.232.204.61 PluginCode hana -configSettings @{"HANA_HDBSQL_CMD" = "C:\Program
Files\sap\hdbclient\hdbsql.exe"}

For Linux:
Example
Set-SmConfigSettings -Plugin -HostName scs-hana.gdl.englab.netapp.com
-PluginCode hana -configSettings @{"HANA_HDBSQL_CMD"="/usr/sap/
hdbclient/hdbsql"}

Backing up databases using PowerShell cmdlets
Backing up a database includes establishing a connection with the SnapCenter Server, adding
resources, adding a policy, creating a backup resource group, and backing up.
Before you begin

•

You must have prepared the PowerShell environment to execute the PowerShell cmdlets.

•

You must have added the storage system connection and created a credential.

About this task

The information regarding the parameters that can be used with the cmdlet and their descriptions can
be obtained by runningGet-Help command_name. Alternatively, you can also refer to the Cmdlet
Reference Guide.
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Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the OpenSmConnection cmdlet.
Example
Open-smconnection

-SMSbaseurl

https:\\snapctr.demo.netapp.com:8146\

The username and password prompt is displayed.
2. Add resources by using the Add-SmResources cmdlet.
Example

This example shows how to add a SAP HANA database of SingleContainer type:
C:\PS> Add-SmResource -HostName '10.232.204.42' -PluginCode 'HANA' DatabaseName H10 -ResourceType SingleContainer -StorageFootPrint
(@{"VolumeName"="HanaData10";"StorageSystem"="vserver_scauto_primary"}
) -SID 'H10' -filebackuppath '/tmp/HanaFileLog' -userstorekeys 'HS10'
-osdbuser 'h10adm' -filebackupprefix 'H10_'
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Example

This example shows how to adds a SAP HANA database of MultipleContainers type:
C:\PS> Add-SmResource -HostName
'scspr0204312001.gdl.englab.netapp.com' -PluginCode 'HANA' -SID 'H11'
-TenantDatabaseName 'abc' -TenantType SingleTenant -DatabaseName
MDC_SN -ResourceType
MultipleContainers -userstorekeys 'KEY01' -StorageFootPrint
@(@{"storagesystem"="10.232.206.5";"volumename"="dummyvol"}) filebackuppath '/tmp/HanaFileLog' -userstorekeys 'HS10' -osdbuser
'h10adm' -filebackupprefix 'H10_'
Note: If you do not specify a value for -filebackuppath and -filebackupprefix, default
values are used. The default OSDBUser for Windows is SYSTEM.
Example

This example shows how to create a non-data volume resource:
C:\PS> Add-SmResource -HostName 'SNAPCENTERN42.sccore.test.com' PluginCode 'hana' -ResourceName NonDataVolume -ResourceType
NonDataVolume -StorageFootPrint
(@{"VolumeName"="ng_pvol";"StorageSystem"="vserver_scauto_primary"}) sid 'S10'

3. Create a backup policy by using the Add-SmPolicy cmdlet.
Example

This example creates a backup policy for a Snapshot copy-based backup:
C:\PS> Add-SmPolicy -PolicyName hana_snapshotbased -PolicyType Backup
-PluginPolicyType hana -BackupType SnapShotBasedBackup

Example

This example creates a backup policy for a File-Based backup:
C:\PS> Add-SmPolicy -PolicyName hana_Filebased -PolicyType Backup PluginPolicyType hana -BackupType FileBasedBackup

4. Protect the resource or add a new resource group to SnapCenter by using the AddSmResourceGroup cmdlet.
Example

This example protects a single container resource:
C:\PS> Add-SmProtectResource -PluginCode HANA -Policies
hana_snapshotbased,hana_Filebased
-Resources @{"Host"="host.example.com";"UID"="SID"} -Description
test -usesnapcenterwithoutfilesystemconsistency

Example

This example protects a multiple containers resource:
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C:\PS> Add-SmProtectResource -PluginCode HANA -Policies
hana_snapshotbased,hana_Filebased
-Resources @{"Host"="host.example.com";"UID"="SID
\TenantDatabaseName"} -Description test usesnapcenterwithoutfilesystemconsistency

Example

This example creates a new resource group with the specified policy and resources:
C:\PS> Add-SmResourceGroup -ResourceGroupName
'ResourceGroup_with_SingleContainer_MultipleContainers_Resources' Resources
@(@{"Host"="sccorelinux61.sccore.test.com";"Uid"="SID"},@{"Host"="scco
relinux61.sccore.test.com";"Uid"="SID\TenantDatabaseName"})
-Policies hana_snapshotbased,hana_Filebased usesnapcenterwithoutfilesystemconsistency -plugincode 'HANA'

Example

This example creates a non-data volume resource group:
Add-SmResourceGroup -ResourceGroupName
'Mixed_RG_backup_when_Remove_Backup_throguh_BackupName_windows' Resources
@(@{"Host"="SNAPCENTERN42.sccore.test.com";"Uid"="H11";"PluginName"="h
ana"},@{"Host"="SNAPCENTERN42.sccore.test.com";"Uid"="H31\H31";"Plugin
Name"="hana"},@{"Host"="SNAPCENTERN42.sccore.test.com";"Uid"="NonDataV
olume\S10\NonDataVolume";"PluginName"="hana"}) -Policies hanaprimary

5. Initiate a new backup job by using the New-SmBackup cmdlet.
Example

This example shows how to backup a resource group:
C:\PS> New-SMBackup -ResourceGroupName
'ResourceGroup_with_SingleContainer_MultipleContainers_Resources'
Policy hana_snapshotbased

-

Example

This example backs up a protected resource:
C:\PS> New-SMBackup -Resources @{"Host"="10.232.204.42";"Uid"="SID
\TenantDatabaseName";"PluginName"="hana"} -Policy hana_Filebased

6. Monitor the job status (running, completed, or failed) by using the Get-smJobSummaryReport
cmdlet.
Example
PS C:\> Get-smJobSummaryReport -JobID 123

7. Monitor the backup job details like backup ID, backup name to perform restore or clone operation
by using the Get-SmBackupReport cmdlet.
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Example
PS C:\> Get-SmBackupReport -JobId 351
Output:
BackedUpObjects
: {DB1}
FailedObjects
: {}
IsScheduled
: False
HasMetadata
: False
SmBackupId
: 269
SmJobId
: 2361
StartDateTime
: 10/4/2016 11:20:45 PM
EndDateTime
: 10/4/2016 11:21:32 PM
Duration
: 00:00:46.2536470
CreatedDateTime
: 10/4/2016 11:21:09 PM
Status
: Completed
ProtectionGroupName
: Verify_ASUP_Message_windows
SmProtectionGroupId
: 211
PolicyName
: test2
SmPolicyId
: 20
BackupName
:
Verify_ASUP_Message_windows_scc54_10-04-2016_23.20.46.2758
VerificationStatus
: NotVerified
VerificationStatuses
:
SmJobError
:
BackupType
: SCC_BACKUP
CatalogingStatus
: NotApplicable
CatalogingStatuses
:
ReportDataCreatedDateTime :

Restoring SAP HANA database using PowerShell cmdlets
Restoring a SAP HANA database backup includes initiating a connection session with the
SnapCenter Server, listing the backups and retrieving backup information, and restoring a backup.
Before you begin

You must have prepared the PowerShell environment to execute the PowerShell cmdlets.
About this task

The information regarding the parameters that can be used with the cmdlet and their descriptions can
be obtained by runningGet-Help command_name. Alternatively, you can also refer to the Cmdlet
Reference Guide.

SnapCenter Software 4.2 Windows Cmdlet Reference Guide
Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the OpenSmConnection cmdlet.
Example
Open-smconnection

-SMSbaseurl

https:\\snapctr.demo.netapp.com:8146/

2. Identify the backup that you want to restore by using the Get-SmBackup and GetSmBackupReport cmdlets.
Example

This example shows that there are two backups available for the restore:
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C:\PS>PS C:\> Get-SmBackup
BackupId
BackupTime
----------------1
11:02:32 AM
2
11:23:17 AM

BackupName
BackupType
------------------Payroll Dataset_vise-f6_08... 8/4/2015
Full Backup
Payroll Dataset_vise-f6_08... 8/4/2015

Example

This example displays detailed information about the backup from January 29th 2015 to February
3rd, 2015:
PS C:\> Get-SmBackupReport -FromDateTime "1/29/2015" -ToDateTime
"2/3/2015"
SmBackupId
: 113
SmJobId
: 2032
StartDateTime
: 2/2/2015 6:57:03 AM
EndDateTime
: 2/2/2015 6:57:11 AM
Duration
: 00:00:07.3060000
CreatedDateTime
: 2/2/2015 6:57:23 AM
Status
: Completed
ProtectionGroupName : Clone
SmProtectionGroupId : 34
PolicyName
: Vault
SmPolicyId
: 18
BackupName
: Clone_SCSPR0019366001_02-02-2015_06.57.08
VerificationStatus
: NotVerified
SmBackupId
SmJobId
StartDateTime
EndDateTime
Duration
CreatedDateTime
Status
ProtectionGroupName
SmProtectionGroupId
PolicyName
SmPolicyId
BackupName
VerificationStatus

:
:
:
:
:
:
:
:
:
:
:
:
:

114
2183
2/2/2015 1:02:41 PM
2/2/2015 1:02:38 PM
-00:00:03.2300000
2/2/2015 1:02:53 PM
Completed
Clone
34
Vault
18
Clone_SCSPR0019366001_02-02-2015_13.02.45
NotVerified

3. Start the recovery process in the HANA studio.
The database is shut down.
4. Restore data from the backup by using the Restore-SmBackup cmdlet.
Note: AppObjectId is "Host"\Plugin\UID, where UID = SID is for single container type
resource and UID = SID\TenantDatabaseName is for multiple containers resource. You can
get the ResourceID from the Get-smResources cmdlet.
Get-smResources

-HostName cn24.sccore.test.com

-PluginCode HANA

Example

This example shows how to restore the database from the primary storage:
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Restore-SmBackup -PluginCode HANA -AppObjectId cn24.sccore.test.com
\hana\H10 -BackupId 3

Example

This example shows how to restore the database from the secondary storage:
Restore-SmBackup -PluginCode 'HANA' -AppObjectId cn24.sccore.test.com
\hana\H10 -BackupId 399 -Confirm:$false -Archive
@( @{"Primary"="<Primary
Vserver>:<PrimaryVolume>";"Secondary"="<Secondary
Vserver>:<SecondaryVolume>"})

The backups will be available in HANA studio for recovery.

Cloning SAP HANA database backups using PowerShell
cmdlets
The clone workflow includes planning, performing the clone operation, and monitoring the
operation.
Before you begin

You must have prepared the PowerShell environment to execute the PowerShell cmdlets.
About this task

The information regarding the parameters that can be used with the cmdlet and their descriptions can
be obtained by runningGet-Help command_name. Alternatively, you can also refer to the Cmdlet
Reference Guide.

SnapCenter Software 4.2 Windows Cmdlet Reference Guide
Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the OpenSmConnection cmdlet.
Example
Open-SmConnection

-SMSbaseurl

https:\\snapctr.demo.netapp.com:8146/

2. Retrieve the backups to perform the clone operation by using the Get-SmBackup cmdlet.
Example

This example shows that two backups are available for cloning:
C:\PS> Get-SmBackup
BackupId
BackupTime
----------------1

BackupName
BackupType
------------------Payroll Dataset_vise-f6_08... 8/4/2015
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11:02:32 AM
2
11:23:17 AM

Full Backup
Payroll Dataset_vise-f6_08... 8/4/2015

3. Initiate a clone operation from an existing backup and specify the NFS export IP addresses on
which the cloned volumes are exported.
Example

This example shows that the backup to be cloned has an NFSExportIPs address of
10.232.206.169:
New-SmClone -AppPluginCode hana -BackupName
scsccore1_sccore_test_com_hana_H73_scsccore1_06-07-2017_02.54.29.3817
-Resources @{"Host"="scsccore1.sccore.test.com";"Uid"="H73"} CloneToInstance shivscc4.sccore.test.com -Suffix '_c12' -mountcommand
'mount 10.232.206.169:%hana73data_Clone /hana83data' preclonecreatecommands '/home/scripts/scpre_clone.sh' postclonecreatecommands '/home/scripts/scpost_clone.sh'
Note: If NFSExportIPs is not specified, the default is exported to the clone target host.

4. Verify that the backups were cloned successfully by using the Get-SmCloneReport cmdlet to
view the clone job details.
You can view details such as clone ID, start date and time, end date and time.
Example
PS C:\> Get-SmCloneReport -JobId 186
SmCloneId
SmJobId
StartDateTime
EndDateTime
Duration
Status
ProtectionGroupName
SmProtectionGroupId
PolicyName
SmPolicyId
BackupPolicyName
SmBackupPolicyId
CloneHostName
CloneHostId
CloneName
SourceResources
ClonedResources
Sally_DRAPER}
SmJobError

:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:

1
186
8/3/2015 2:43:02 PM
8/3/2015 2:44:08 PM
00:01:06.6760000
Completed
Draper
4
OnDemand_Clone
4
OnDemand_Full_Log
1
SCSPR0054212005.mycompany.com
4
Draper__clone__08-03-2015_14.43.53
{Don, Betty, Bobby, Sally}
{Don_DRAPER, Betty_DRAPER, Bobby_DRAPER,
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Troubleshooting data protection operations
If you encounter unexpected behavior while performing data protection operations, you can use the
log files to identify the cause and resolve the problem.
You can download the log files from the SnapCenter user interface by clicking Monitor > Logs >
Download.

File-Based Backup workflow fails at custom file path
Description
The File-Based Backup workflow fails during the Start file based backup if the path provided does
not have proper permission.
Error message
System.Exception : SmJobId [1525] Failed! JobError: [SCC-00301: Start of
backup type [FileBasedBackup] for plug-in [hana] failed with error
message:* 447: backup could not be completed: [2000004] Cannot open file
""/.H30_sccorelinux61_sccore_test_com_hana_H30_H30_sccorelinux61_06-14-20
18_12.58.00.3411_databackup_0_1" ((closed, mode= W, access= rw-r-----,
flags= DIRECT|TRUNCATE|MULTI_WRITERS|UNALIGNED_SIZE), factory= (root=
"/tmp/HanaFileLog/SYSTEMDB/" (access= rw-r-----, flags= AUTOCREATE_PATH|
DISKFULL_ERROR, usage= DATA_BACKUP, fs= UNKNOWN (btrfs), config=
(async_write_submit_active=on,async_write_submit_blocks=all,async_read_su
bmit=on,num_submit_queues=1,num_completion_queues=1,size_kernel_io_queue=
512,max_parallel_io_requests=64,min_submit_batch_size=16,max_submit_batch
_size=64))", rc=2: No such file or directory SQLSTATE: HY000Start file
backup query failed for database [SYSTEMDB] and comment
[sccorelinux61_sccore_test_com_hana_H30_H30_sccorelinux61_06-14-2018_12.5
8.00.3411]StartAppBackup Failed]

Corrective action
Perform the following actions:
•

Ensure that the file in the custom path and the parent directory in which it resides have read,
write, and execute permission for other users.

•

Change the ownership of the file in the custom path to <sid admin> user. You must ensure that the
parent folders have the right permissions for the sid admin to access the required folders.

If the above corrective actions fail, perform the following action:
Manually create the folders SYSTEMDB and DB_<SID> as sid admin user in the custom path given.

User store key not found
Description
The backup operation fails during the quiesce operation if the user store key is not found.
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Error message
SCC-00164: Application quiesce for plug-in [hana] failed with exit code
[1] and with error: The verification of HDB Secure User Store Key: HS73
failed with error: * -10104: Invalid value for KEY (HS73)[hdb-00008]
Running command on HANA node failed. Unable to execute hdbsql statement
using the hdbuserstore keys provided in the config. Update the userstore
keys and try again.

Corrective action
Update the user store key and try again.

Invalid user store key
Description
The backup operation fails during the quiesce operation if the user store key has an invalid user
name, password, or port number.
Error message
SCC-00164: Application quiesce for plug-in [hana] failed with exit code
[1] and with error: [hdb-00004] Connection failed, as the connection to
the HANA node was refused. Connecting to database (SID: H73) using the
following HDB User Store Keys: [HS73] failed with error: [hdb-00004]
Connection failed, as the connection to the HANA node was refused.
Unable to execute hdbsql statement using the hdbuserstore keys provided
in the config. Update the userstore keys and try again.

Corrective action
Update the user store key and try again.

Unable to access SAP HANA system
Description
The backup operation fails during the quiesce operation if the SAP HANA system is not accessible or
the host is down.
Error message
SCC-00164: Application quiesce for plug-in [hana] failed with exit code
[1] and with error: [hdb-00004] Connection failed, as the connection to
the HANA node was refused. Connecting to database ( SID: H73 ) using the
following HDB User Store Keys: [HS73] failed with error: [hdb-00004]
Connection failed, as the connection to the HANA node was refused.
Unable to execute hdbsql statement using the hdbuserstore keys provided
in the config. Update the userstore keys and try again.

Corrective action
Update the user store key and try again.

Troubleshooting data protection operations | 47

Unable to access tenant database
Description
The backup operation fails during the quiesce operation if the tenant database is inaccessible or
invalid tenant database name is provided.
Error message
SCC-00164: Application quiesce for plug-in [hana] failed with exit code
[1] and with error : Tenant Database : [R85INVALID] either does not
exist or it is inactive Client Verification failed for resource:
[R85\R85INVALID]

Corrective action
Verify that the tenant database is valid and active.

File-Based Backup workflow fails
Description
The File-Based Backup workflow fails during the Start file based backup operation if the path
provided does not exist.
Error message
SCC-00301: Start of backup type [FileBasedBackup] for plug-in [hana]
failed with error message: * 447: backup could not be completed:
[2000002] Cannot create root directory "/invalid/", rc=13: Permission
denied SQLSTATE: HY000 [hdb-00008] Running command on HANA node failed.
Start file backup query failed for comment
[shivscc4_sccore_test_com_hana_H73_c12_shivscc4_05-17-2017_02.20.48.3132]
StartAppBackup Failed

Corrective action
Provide the right path and try again.

Unable to find Snapshot copy after successfully creating the
backup
Description
Backup operations with an update to SnapVault or SnapMirror might fail.
Depending on the rate of change of data between Snapshot copies, the time taken to update the
Snapshot copy to secondary varies. If the delta between Snapshot copies is very high, it is
recommended to change SnapshotCheckRetry and SnapshotCheckTimeout values.
Error message
Snapshot copy could not be found on the destination storage system.
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Corrective action
You must include the following parameters and specify the value in the appsetting section of the
SMCoreServiceHost.exe.Config file located under SmCore in the SnapCenter Server.
•

<add key="SnapshotCheckRetry" value=retry_value/>
The retry_value assigned to SnapshotCheckRetry defines the maximum number of retries that
are performed to discover the Snapshot copies on the secondary location.

•

<add key="SnapshotCheckTimeout" value=timeout_value/>
The timeout_value (milliseconds) assigned to SnapshotCheckTimeout defines the wait or
sleep period for every retry.

Backup operation fails if Snapshot copies on the secondary
storage reaches maximum limit
Description
When the number of Snapshot copies on the secondary storage (mirror-vault) reaches the maximum
limit, the activity to register backup and apply retention in the backup operation fails.
Error message
This Snapshot copy is currently used as a reference Snapshot copy by one or
more SnapMirror relationships. Deleting the Snapshot copy can cause future
SnapMirror operations to fail.

Corrective action
You should configure SnapMirror retention policy for the secondary storage to avoid reaching the
maximum limit of Snapshot copies on the secondary storage.

Catalog entries are not deleted after volume based restore
operation
Description
After the volume based restore operation, the backup metadata is deleted from the SnapCenter
repository but the backup catalog entries remain in SAP HANA catalog.
Corrective action
, you must click on job details to see the warning sign of
Though the backup job status displays
some of the child tasks. Click on the warning sign and delete the indicated backup catalog entries
manually.

Invalid HDBSQL OS username
Description
The backup operation fails during the quiesce operation if the HDBSQL OS username provided is
invalid.
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Error message
SCC-00164: Application quiesce for plug-in [hana] failed with exit code
[1] and with error : Verification of HDBSQL OS User : [hdbadmin] failed
with error : [su: user hdbadmin does not exist]

Corrective action
Update the HDBSQL OS username, and then try again.

Backup operation fails
Description
The backup operation fails during the quiesce operation if the HDBSQL path is not set.
Error message
SCC-00164: Application quiesce for plug-in [hana] failed with exit code
[1] and with error : Verification of HDBSQL OS User: [hdbadmin] failed
with error: [su: user hdbadmin does not exist] SCC-00164: Application
quiesce for plug-in [hana] failed with exit code [1] and with error:
Verification of HDBSQL_CMD [hdbsql] failed with error: [bash: hdbsql:
command not found...]. Set valid HDBSQL_CMD for the SAP HANA plug-in on
this host using "Set-SmConfigSettings -Plugin -HostName hostname PluginCode hana �configSettings
@{"HANA_HDBSQL_CMD"="path_to_HDBSQL_CMD"} " PowerShell cmdlet from
SnapCenter Server.

Corrective action
Configure the HDBSQL path by running the cmdlet, or include the HDBSQL client path as part of
the system path.

Backup fails with error: Storage system(s) may need to be
added, also ensure that the associated host is in a
connected state
Description
A backup failed because the preferred IP address that was configured for the SVM went down. When
the preferred IP comes up again, the SnapCenter cache is not automatically refreshed. Therefore,
SnapCenter could not find the Preferred IP when attempting to perform the backup.
Corrective action
Refresh the SnapCenter cache for the SVM:
1. In the left navigation pane of the SnapCenter GUI, click Storage Systems.
2. In the Storage Systems page, select the storage system used by the backup, and then click
Modify.
3. Make sure that the Preferred IP check box is selected and that the IP is correct.
4. Reenter the storage system password, and then click OK.
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This action refreshes the SnapCenter cache and updates the storage system configuration.

Cannot enable SAP HANA
Description
If the Java Runtime Environment (JRE) 1.7 is installed on a host with German operating system and
if this host is added to the SnapCenter Server, you cannot enable SAP HANA.
Error message
Object reference not set to an instance of an object.

Corrective action
Upgrade the JRE version to 1.8.

Clone split estimation fails when the aggregate does not
have space
Description
If the aggregate has no space, clone split estimation fails.
Corrective action
Increase the space on the aggregate.

Clone split start operation fails
Description
The clone split start operation fails when one of the following conditions are met:
•

The volume or aggregate is offline.

•

A clone split operation, backup operation, or restore operation is in progress on the clone
resource.

•

A clone split operation is in progress on an intermediate clone.

Corrective action
•

If the volume or aggregate is offline, check the status of the volume or aggregate on the storage
system and bring it back online.

•

If a clone split operation, backup operation, or restore operation is in progress on the clone
resource, restart the clone split operation after the clone split operation, backup operation, or
restore operation is complete.

•

If a clone split operation is in progress on an intermediate clone, split the child clones, and then
restart the clone split start operation on this clone.
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Clone split operation stops responding
Description
The clone split operation stops responding if the SMCore service restarts.
Corrective action
Use the Stop-SmJob cmdlet to stop the clone split operation, and then perform the clone split
operation again.

Databases on which the clone split operation was performed
are listed as clones
Description
During the clone split operation, if the SMCore service restarts, the status of the operation will not be
sent to the server. Therefore, the databases on which the clone split operation was performed are
listed as clones in the Resources page.
Corrective action
Run the split clone cmdlet again to clean the clone metadata in SnapCenter repository.

Restore operation times out
Description
During a restore operation that accesses VMs, the vCenter Server timed out while waiting for a
response from the SnapCenter server.
This error can occur when VMotion or the actual restore operation exceeds the timeout set for
responses from the SnapCenter server.
Error message
The operation has timed out

Corrective action
You can increase the SnapCenter server timeout value by including the following REST API in the
appsetting section of the SMCoreServiceHost.exe.Config file located under SmCore in the
SnapCenter Server:
<add key="RESTTimeout" value="timeout-value"/>

The default timeout value is 10800000 (in milliseconds, which is 3 hours). You can increase that
value, in milliseconds, as needed.
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Managing policies
You can create, copy, modify, view, and delete backup policies.
About this task

You can perform the following tasks related to policies:
•

Create a policy.

•

Modify a policy.
Note: You can change the schedule type for a policy only after you detach the policy. To

change the schedule you must modify the resource group.
•

Copy a policy by accepting the default name or typing a new name.

•

Detach a policy from a resource group.

•

Delete a policy.

Related tasks

Creating backup policies for SAP HANA databases on page 15

Detaching policies
You can detach policies from a resource or resource group any time that you no longer want those
policies to govern data protection for the resources. You must detach a policy before you can delete it
or before you modify the schedule type.
About this task
Attention: You cannot detach a policy from a resource or resource group if it is the only policy

attached.
Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, select Resource Group from the View list.
3. Select the resource group, and then click Modify Resource Group.
4. In the Policies page of the Modify Resource Group wizard, from the drop-down list, clear the
check mark next to the policies you want to detach.
Note: You cannot detach the last remaining policy from an individual resource because every
resource must have at least one policy attached. Therefore, if you want to delete or modify the
only policy attached to a resource, you must perform the following:

a. Attach a second placeholder policy.
b. Detach the original policy from the resource.
5. Make any additional modifications to the resource group in the rest of the wizard, and then click
Finish.
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Modifying policies
You can modify the replication options, Snapshot copy retention settings, error retry count, or scripts
information while a policy is attached to a resource or resource group. You can modify the schedule
type (frequency) only after you detach a policy.
About this task

Modifying the schedule type in a policy requires additional steps because the SnapCenter Server
registers the schedule type only at the time the policy is attached to a resource or resource group.
If you want to...

Then...

Add an additional schedule
type

Create a new policy and attach it to the necessary resources or
resource groups.
For example, if a resource group policy specifies only hourly
backups and you want to add daily backups also, you can create a
policy with a daily schedule type and add it to the resource
group. The resource group would then have two policies: hourly
and daily.

Remove or change a schedule
type

1. Detach the policy from every resource and resource group
that uses that policy.
2. Modify the schedule type.
3. Attach the policy again to all the resources and resource
groups.
For example, if a policy specifies hourly backups and you want
to change that to daily backups, you must detach the policy first.
Note: You cannot detach the last remaining policy from a
individual resource because every resource must have at least
one policy attached. Therefore, if you want to modify the
schedule type of the only policy attached to a resource, you
must perform the following:

1. Attach a second placeholder policy.
2. Detach the original policy from every resource and
resource group that uses that policy.
3. Modify the schedule type.
4. Attach the modified policy again to all the resources and
resource groups.
5. Detach the placeholder policy.

Steps

1. In the left navigation pane, click Settings.
2. In the Settings page, click Policies.
3. Select the policy, and then click Modify.
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4. Modify the information, and then click Finish.

Deleting policies
If you no longer require policies, you might want to delete them.
Before you begin

You must have detached the policy from resource groups if the policy is associated with any resource
group.
Steps

1. In the left navigation pane, click Settings.
2. In the Settings page, click Policies.
3. Select the policy, and then click Delete.
4. Click Yes.
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Managing resource groups
You can create, modify, and delete resource groups. You can also perform backup and verification
operations on resource groups.
About this task

You can perform the following tasks related to resource groups:
•

Create a resource group.

•

Modify a resource group by selecting the resource group and clicking Modify Resource Group
to edit the information you provided while creating the resource group.
Note: You can change the schedule while modifying the resource group. However, to change
the schedule type you must modify the policy.
Note: If you remove resources from a resource group, the backup retention settings defined in
the policies currently attached to the resource group will continue to be applied to the removed
resources.

•

Create a backup of a resource group.

•

Create a clone of a backup.
You can clone from the existing backups of SQL, Oracle, Windows file systems, custom
applications, and SAP HANA database resources or resource groups.

•

Create a clone of a resource group.
This operation is supported only for SQL resource groups (which contains only databases). You
can configure a schedule for cloning a resource group (clone lifecycle).

•

Prevent scheduled operations on resource groups from starting.

•

Delete a resource group.

Related tasks

Creating resource groups and attaching policies on page 17
Backing up resource groups on page 22

Stopping and resuming operations on resource groups
You can temporarily disable scheduled operations from starting on a resource group. Later when you
want, you can enable those operations.
Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, select Resource Group from the View list.
3. Select the resource group and click Maintenance.
4. Click OK.
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After you finish

If you want to resume operations on the resource group that you had put on maintenance mode, select
the resource group and click Production.

Deleting resource groups
You can delete a resource group if you no longer need to protect the resources in the resource group.
You must ensure that resource groups are deleted before you remove plug-ins from SnapCenter.
Before you begin

If you are managing SQL or Windows file system resources, you must have manually deleted all
clones created for any of the resources in the resource group.
About this task

You can optionally force the deletion of all backups, metadata, policies, and Snapshot copies
associated with the resource group.
Note: In a SnapVault relationship, the last Snapshot copy cannot be deleted; therefore, the resource
group cannot be deleted. Before deleting a resource group that is part of a SnapVault relationship,
you must remove the SnapVault relationship and then delete the last Snapshot copy.
Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, select Resource Group from the View list.
3. Select the resource group, and then click Delete.
4. Optional: Select the Delete backups and detach policies associated with this Resource Group
check box to remove all backups, metadata, policies, and Snapshot copies associated with the
resource group.
5. Click OK.
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Deleting SAP HANA database backups
You can delete SAP HANA database backups if you no longer require the backup for other data
protection operations.
Before you begin

All associated clones must have been deleted. If a backup is associated with a cloned resource, you
cannot delete the backup.
Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, either select the resource or resource group from the View drop-down list.
3. Select the resource or resource group from the list.
The resource or resource group topology page is displayed.
4. From the Manage Copies view, select Backups from the primary storage systems.
You cannot delete the backups that are on the secondary storage system.
5. Select the backup, and then click

.

The associated SAP HANA catalogs of the backup are also deleted.
6. Click OK.
Related information

SnapCenter Software 4.2 Windows Cmdlet Reference Guide
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Deleting SAP HANA database clones
You can delete clones if you find them no longer necessary.
About this task

A clone that has been cloned again cannot be deleted. For example, if the production database db1 is
cloned to db1_clone1 and subsequently cloned to db1_clone2, and you decide that you want to
delete db1_clone1, you must first delete db1_clone2, and then delete db1_clone1.
Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, either select the resource or resource group from the View drop-down list.
3. Select the resource or resource group from the list.
The resource or the resource group topology page is displayed.
4. From the Manage Copies view, select Clones either from the primary or secondary (mirrored or
replicated) storage systems.
5. Select the clone, and then click

.

6. Optional: In the Delete Clone page, perform the following actions:
a. In the Pre clone delete field, enter the commands that should be run before deleting the clone.
b. In the Unmount field, enter the command to unmount the clone before deleting the clone.
7. Click OK.
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How to send comments about documentation and
receive update notifications
You can help us to improve the quality of our documentation by sending us your feedback. You can
receive automatic notification when production-level (GA/FCS) documentation is initially released or
important changes are made to existing production-level documents.
If you have suggestions for improving this document, send us your comments by email.

doccomments@netapp.com
To help us direct your comments to the correct division, include in the subject line the product name,
version, and operating system.
If you want to be notified automatically when production-level documentation is released or
important changes are made to existing production-level documents, follow Twitter account
@NetAppDoc.
You can also contact us in the following ways:
•

NetApp, Inc., 1395 Crossman Ave., Sunnyvale, CA 94089 U.S.

•

Telephone: +1 (408) 822-6000

•

Fax: +1 (408) 822-4501

•

Support telephone: +1 (888) 463-8277
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